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Preface 
 

 
Introduction: 

 

 

This software release notes provide a concise overview of additional 
features, enhancements and revisions improving production version 
between 5.4.097 to 5.4.178.  This document is designed to be informative 
only.  For guidance on instructional use and implementation of the 
feature, users should reach out to Maestro Support for assistance or visit 
http://www.elearning.maestropms.com for documentations. 

  

 
Audience: 

 

 This release notes summary is directed to all users of the Maestro PMS 
software version between 5.4.097 to 5.4.178.001. 

  

 
Advisories: 

 

 Contact upgrades@maestropms.com to schedule an upgrade to version 
5.4.178. 

 
When upgrading to the Maestro Version 5.4.178, all users of Maestro 
Web will have to clear web browser cached history after upgrade is 
completed. 

 

 

Customer Support: 
 

  

To contact Maestro Support:  

Call (905) 940-1924  

Email support@maestropms.com  

  

Maestro elearning:  

http://www.elearning.maestropms.com/  

 

  

  

mailto:lliang@maestropms.com
http://www.elearning.maestropms.com/
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Revision History:  
 

Date Description of Change 

2019-08-30 Updated Front Desk and Incident Pending Resolution. 

2019-02-07 
Updated Front Desk, Front Desk Report, Sales and 
Catering, Spa and Activities, Facility, Owner, ResWave, 
Maestro Web, Interfaces, and Incident Pending Resolution. 

2018-08-21 
Updated Front Desk, Front Desk Report, Spa and 
Activities, Facility, Member, Retail POS, Global, Interfaces, 
Incident Pending Resolution. 

2018-07-04 
Updated Important Notices, Front Desk, Front Desk Report, 
Sales and Catering, Spa and Activities, Member, Crystal 
Report, Interfaces, Incident Pending Resolution. 

2018-06-12 
Updated Important Notices, Front Desk, Reswave, Owner, 
Global, Interfaces, Incident Pending Resolution.  

2018-05-31 
Updated Front Desk, Spa and Activities, Member, Global 
Maintenance, ResWave, Interfaces, Incident Pending 
Resolution. 

2018-05-09 

Updated Front Desk, Front Desk Report, Sales and 
Catering, Member, Owner, Global Maintenance, Maestro 
Web, Interfaces, QlikView/Analytics, Incident Pending 
Resolution. 

2018-04-10 
Updated Front Desk, Front Desk Report, Spa and 
Activities, Interfaces, Incident Pending Resolution 

2018-03-27 
Updated Front Desk, Loyalty, Interfaces, Incident Pending 
Resolution.  

2018-03-23 
Updated Front Desk, Spa and Activities, Incident Pending 
Resolution. 

2018-03-15 Updated Incident Pending Resolution 

2018-03-12 Updated Crystal Report, Incident Pending Resolution 

2018-03-07 Updated Reswave, Interfaces 

2018-03-06 

Updated Front Desk, Front Desk Reports, Spa and 
Activities, Member, Owner, Work Order, Global 
Maintenance, ResWave, Interfaces and Incident Pending 
Resolution. 

2018-02-22 
Updated Front Desk, Sales and Catering and Incident 
Pending Resolution 

2018-02-05 
Updated Front Desk, Interface, Crystal Report, 
QlikView/Analytics and Incident Pending Resolution. 

2018-01-30 
Updated Front Desk, Spa and Activity, ResWave, Mobile 
App, Interface, Crystal Report, QlikView/Analytics and 
Incident Pending Resolution. 

2018-01-22 
Updated Spa and Activity, Interface, Crystal Report and 
Incident Pending Resolution. 

2018-01-17 Initial release note publication. 
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Important Notices 

 
Upgrade to high maestro 5.4 version may require the installation of crystal 2013 reporting which will open 
all crystal reports in a PDF viewer.  All standard crystal reports will be converted and installed however, 
customized crystal reports will require conversion one report at a time.  Installation of Maestro Web will 
also be required with use of crystal 2013 reporting.   
 
Users of Owners Management and Members Module will encounter a change in Owner statements and 
Member Statements and may require a statement conversion to crystal 2013 for report printing and 
emailing of statements.  Installation of maestro web on the server for browser use of maestro PMS 
software will be performed for use of crystal 2013, however maestro web does not have to be used by 
users.  Some requirements and server software installations to expect are as follows: 

 
Crystal 2013 reporting and System Requirements 

▪ 64-Bit Windows Operating System 
▪ PDF viewer  
▪ Java server JRE edition 
▪ Libre Office (.odt / .doc format for word merge) 
▪ Crystal 2013 report conversions 
▪ Minimum RAM 8GB 

 
Credit Card EMV Devices 
Use of EMV devices at the property may require the maestro PMS software to be upgraded to a high 5.4 
version to utilize pin pad devices. 

Basics of EMV devices 
▪ Entry of the Credit Card via EMV requires “Assign a pin pad” in maestro.  Users will be 

prompted to “Continue / Payment / Authorise” and complete credit card processing via 
EMV.  Once assign pin pad is used, the maestro session would retain that same pin pad 
unless user logs out or deassigns pin pad manually.    

▪ Manual entry of the credit card in maestro, users must DEASSIGN the pin pad and 
normal entry of the credit card into maestro and processing can be performed. 

▪ Depending on the credit card processor, alternate steps may be required for manually 
EMV entry of the credit card.  Please call Maestro Support for assistance.   
 

Group Master / Sub Groups Inventory 
Use of Group Reservation Master and Sub-Accounts will experience a change in behaviour in regards to 
the sharing of Inventory.  Upgrade to version 5.4.151 or higher, inventory relationship has been enhanced 
to utilise master inventory to distribute to sub-account inventory blocks.  Prior to this, there was no 
inventory sharing amongst Master and Sub-Account group reservations.  Please call Maestro Support for 

assistance.   
  
Member Module 
Use of Primary and Secondary Member Profiles will experience a change in behaviour in regards to 
Member Status.  Upgrade to version 5.4.161 or higher will notice Secondary Member Profiles some fields 
locked based on Member Status as well as Join/Expiry Date freely open based on unique profile settings 
outlined as per property.  Please call Maestro Support for assistance.   
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Front Desk 
 

Description Version Incident  

NEW – Quick Availability screen has been enhanced to allow users the ability to 
display 6 rate types on a single screen. 

5.4.110 224086 

 
Configuration in: 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to Option 603 and update Data Option to Y. 
 
Front Desk Maintenance> Setup Menu> Order of Reservation Screens> Page down 
to "CREATE" Res Function> add a line where user feels best place> Lookup(F8) on 
Program for FDAVAILAB3>Force (Frc) = N > Dialogue (Dlg) - N>Title will default in. 

NEW – Privileges Information on assignment chart has been enhanced to show 
Package Reconciliation components allowed, consumed and remaining.  

5.4.107 192702 

Users now have the ability to view package reconciliation components that are 
setup within the rate type, allowed, consumed and remaining components from 
assignment chart on guest reservation. 

 
Access via: 
Front Desk> Reservation Menu>Guest Reservations>Inventory Menu> Assignment 
Chart>Verify Menu> Privileges Information will list package reconciliate components 
for the guest reservation and their consumption status. 

NEW – Users will now receive pop up message when an Other Charge is being 
booked in a different property other than the room inventory on the reservation.  

5.4.108 214011 
Message will display "Warning: This reservation is associated to another property 
Check before posting/settling". 

NEW – Client Profile Address will auto default to the AVS credit card screen when 
Global System Option 702 is setup. 

5.4.098 216573  
Configuration in: 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to Option 702 and update Data Option to Y. 

NEW – Building description has been added to Guest Reservation screen. 

5.4.108 217659  
Access via: 
Displayed on guest reservation near the Building Code. 

NEW – On Group Reservation, Group Spa Booking List has been added to the 
Inventory drop down menu, where user can book, view, and cancel single/multiple 
spa bookings. 

5.4.109 52364  
Access via: 
Front Desk> Reserve Menu>Group Reservations>Window Menu>Inventory>Group 
Spa Booking List will list spa group blocks/bookings link to group master /members. 
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Description Version Incident  

NEW – PRINT ALL option is now available when using Rate Search function.  
Users have the ability to print entire list of rates displayed based on Rate Type 
Search criteria. 

5.4.119 229125 
 
Access via: 
Front Desk Maintenance> Rates Menu> Rate Type> Select the desired Rate 
Category with lookup(F8)>Look up(F8) on the Rate Type field> Enter the desired 
Rate Type search criteria and press Search>On the Rate Lookup screen>Select 
File Menu > Print All. 

NEW – Property display order has been enhanced in multi property environment.  
Upon the initial login to Maestro, or switching between properties, the displayed 
order of available properties can now be sorted based on setup. 

5.4.122 231663 
 
Configuration in: 
Global Maintenance> Codes Menu> Hotels-Properties> Window Menu>Select 
Display Order> Update the number in the second column (left of the Description 
column) to the desired order.  

NEW – Users can now email Maestro Support directly from Front Desk.  Currently, 
this feature can be performed from the Assignment Chart under Guest 
Reservations, where the user's query, name and contact information (given they are 
configured in Extra Information under Clerk Code Maintenance in Global) will be 
forwarded as part of the message. 

5.4.125 232627 

 
Configuration in: 
Setup Maestro Support Email as the recipient: 
Global Maintenance>Setup Menu>Global System Options Maintenance> Page 
down to Option 723, update Data field to support@maestropms.com or Call 
Maestro Support for assistance. 

 
Ensure Maestro user has contact information: 
Global Maintenance> Security Menu>Clerk Code Maintenance> Select the desired 
Clerk >Window Menu>Extra Information and update the desired contact 
information. 

 
Access Via: 
Front Desk> Reserve Menu>Guest Reservations>Inventory Menu>Assignment 
Chart>Help Menu> Select Email Help>Enter question in the Email Text Box, and 
select OK, email will be send to Maestro Support. 

Rate Type Policy Text Code has been enhanced to be property specific. 
 
Access via: 
Front Desk Maintenance> Codes Menu>Policy Text Code> Update Dflt (Default) to 
Y> Window Menu> Property Availability> Lookup(F8) to add the Property Code. 

5.4.114 224879 

Tax calculation has been enhanced on early departure, and guest reservations with 
different daily rates. 

5.4.115 219655 

Enhanced scrolling capability of Suite Availability and Suite Space Chart. 5.4.114 226315 

  

mailto:support@maestropms.com
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Description Version Incident  

NEW – Strenuous Housekeeping Rules provide a new way of auto assigning 

Housekeeping Services.  It identifies rooms which require ‘strenuous’ cleaning and 

their sizes, and varies the workload of attendants according to the number of 

strenuous rooms and total room area assigned.  Please call Maestro Support for 

assistance. 

 

When Strenuous Housekeeping rules is activated: 

- Room is identified as strenuous when it is check out or stayovers with 

cot/rollaway/pet/crib (optional).   

- Room area is used in place of the credit assigned to the housekeeping 

service.   

- Strenuous assignment rules will default with a limit of 5000 square feet 

(total room area), and 9 strenuous rooms per attendant per shift.  

- If the number of strenuous room increases in auto Housekeeping 

assignment, the maximum allowed area will decrease by 500 square feet 

per additional room. 

5.4.136 

226912 
239302 
239651 
238976 

Configuration in: 

Setup Room Size: 

Global Maintenance>Setup Menu> Building/Rooms Inventory>Page down to a valid 

building>Window Menu>Room Number Maintenance>Update the Area column for 

each room number with size in square feet. 

Setup Strenuous Housekeeping Rules: 

Front Desk Maintenance>Setup Menu> Housekeeping Configuration>select 

Strenuous Housekeeping Rules>4 fields will default to the following values: 

- Normal maximum area per shift = 5000 (in square feet) 

- Reduction in maximum area = 500 (in square feet) 

- For each strenuous room after = 9 (measure in room, means reduction in 

area applies on the 10th room and onward) 

- Checkout will default with value Y (any check out room will be identified as 

strenuous) 

Additional strenuous rules can be setup for stay over rooms, with Service 

code/other charge/housekeeping service.  Please call Maestro Support for 

assistance. 

 

Activate Strenuous Housekeeping Rules: 

Front Desk Maintenance>Setup Menu> Housekeeping Configuration>Option 

Settings> update Follow Strenuous Assignment Rules to Y. 

Access Via: 

Front Desk> Housekeeping>Housekeeping Assignment> Each Service will now list 

twice, with one row for strenuous and one row for normal service.  The Strenuous 

service will be mark with an asterisk symbol. 

Corrected spelling/grammar on error message displayed, when performing folio 
detail or batch transfer with posting code restriction. 

5.4.115 227147 
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Description Version Incident  

Housekeeping Floors has been enhanced to appear on Assignment Sheets if 
configured. 

5.4.115 224622 
 
Configuration in: 
Global Maintenance> Setup Menu> Building/Rooms Inventory>Page down to the 
desired Building>Window Menu> Room Number Maintenance>Update the Floor 
column for each room number with the desire floor number. 

For Group Reservation with charge routing rule, Maestro has been enhanced to 
NOT allow charges, to be routed to a cancelled group reservation.  New pop up 
message will alert user if charges cannot be routed during group member checkout 
process. 

5.4.115 225146 

Guarantee by on the Guest/Group reservation has been enhanced, where the 
guarantee type can be update while the reservation is in Reserved or Inhouse 
status. 

5.4.116 219309 

Enhanced extra person factoring computation speed and accuracy with Global 
System Option 705 is set to Y. 

5.4.116 224896  
Configuration in: 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to Option 705 and update Data to Y. 

Assignment Chart has been enhanced to display Charge and Grand Total 
accurately with rate changes. 

5.4.116 
5.4.119 

227520 
227273 

Enhanced the ability to change/modify/remove Housekeeping Service Charges on 
an individual reservation. 

5.4.119 228886 

Enhanced rooms returning from off market process, Maestro will now allow property 
specific return time. 

5.4.125 228827 

Enhanced rate amount change process performed on Assignment chart, the 
selected days options (i.e. "One day", "All Days" and etc.…) will apply correctly. 

5.4.1119 229359 

Group Block Spa Time Slots under Group Reservations, will now unblock spa times 
when group reservation has date change or cancelled. 

5.4.119 52210 
 
Access via: 
Front Desk>Reserve Menu>Group Reservations> Inventory>Group Block Spa Time 
Slots will release all spa group block automatically when group reservation has date 
changed or been cancelled. 

Enhanced folio printing process for folios created in Accounts Receivable. 5.4.121 229909 

Enhanced Update Multiple Rooms under Housekeeping, to allow batch 
housekeeping status update on rooms assigned to a specific attendant. 
 
Access via: 
Front Desk>Housekeeping Menu>Housekeeping>Window Menu>Select Update 
Multiple Rooms>Select an appropriate housekeeping action and an on-duty 
Housekeeper via lookup(F8)>Select Update to complete batch process. 

5.4.125 229894 

Hurdled rate types can now have unique Source of Business and Sub Source when 
specifically assigned on the rate type. 

5.4.121 229807 

Enhanced the Batch Travel Agency display under Group Reservations, where the 
group name will display accurately. 

5.4.122 230146 
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Description Version Incident  

Folio is now capable of displaying VIP status on both Guest and Group 
Reservation. 

5.4.122 231444 

Enhanced the process for manual Housekeeping Room Assignments to store and 
print accurately. 

5.4.126 227995 

Enhanced the handling of response message from Credit Card Vendors and the 
proceeding actions in Maestro. 

5.4.130 231016 

When user attempts to change arrival date on inhouse reservation, Maestro will 
enforce the error message "Cannot change arrival date"; and revert reservation 
back to its original arrival date.  

5.4.125 229847 

Enhanced Manager's Override calculation, to ensure if Derived Base Rate is part 
of Rate group, Rate Modification yields target the specific Rate Group will be 
applied to the Derived Base Rate. 

5.4.125 232883 

Enhanced rate calculation speed for Rate Modification Yields that are control by 
Company/Tour Operator. 

5.4.125 233122 

Enhanced Priority Rate selection on Group masters who are attached to Tour 
Operator, where only the specifically picked Priority Rate will be used for group 
member reservation. 

5.4.126 225141 

Enhanced program routines to ensure keyed revenue postings that are required 
on maestro revenue reports are properly collected.  Routine will also ensure 
forecasting figures, Group master details (inventory and revenue) are being rebuilt 
appropriately during night audit. 

5.4.126 
230997, 
234011, 
233729 

Enhanced the ability to book Other Charges that are set up as a variable package. 5.4.126 233553 

Enhanced navigational function on Rate Chart in Front Desk, user can now 
browse through the query results via page up/down. 

5.4.126 234010 

Increased caching for room type groupings, and ensured the cached rates are 
computing accurately and promptly (changes will apply within 30 seconds in 
Maestro). 

5.4.126 
234075, 
237141 

Enhanced Quick and long availability screens to navigate through multiple rates 
displayed (arrow to right and left) accurately. 

5.4.127 234155 

Room Type Grouping display has been enhanced to show new/existing room type 
groupings of all sizes, accurately with lookup (F8) function on Room Type 
Grouping and Manager's Overrides screens. 

5.4.128 
234318 
237659 

Enhanced Tax Exemption displayed on Assignment Chart under Guest 
Reservations.  When Tax Exemptions are applied to client/folio, the corresponding 
exempted taxes will no longer show on Assignment Chart. 

5.4.128 234940 

Enhanced Resort Fee display on Proforma Consolidated Invoice. 5.4.128 234932 

Enhanced the ability to modify/remove housekeeping charges on Guest 
Reservation and ensured the Assignment Chart will re-calculate charges 
immediately. 

5.4.129 235144 

Enhanced the Credit Available display on Guest/Group Reservations, ensured it 
will display credit card Pre-authorization taken, or when a House Limit has been 
added.  

5.4.130 236556 

Enhanced the Night Audit pre-statistics verify process to improve night audit 
speed. 

5.4.132 237028 

Enhanced Group event in Group Reservation, where typically gets its entry from a 
Sales and Catering booking, or manual entry from user, it will now display data in 
its original format, instead of normalizing the characters. 

5.4.126 222015 

Enhanced the number of emails sent displayed within the GEM Survey 
Dashboard, calculating correct number of sent surveys now.  

5.4.116 225204 
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Description Version Incident  

Enhanced selection display within Night Audit Breakdown configuration setup on 
Rate Types. 

5.4.119 47652 

Enhanced Assignment Chart display for Guest Reservation with spa package 
reconciliation components. 

5.4.117 228519 

Enhanced Web Rate Type by property to allow Rate Description be edited on with 
correct date. 

5.4.120 228140 

Enhanced folio printing process with new programing to better track reservation 
numbers. 

5.4.125 233123 

Enhanced Housekeeping screen scrolling capability, to accurately display 
housekeeping status. 

5.4.133 235894 

Ensure Housekeeping assignment will show correct credit amount without 
Strenuous Housekeeping rule turn on 

5.4.134 
238976 
239302 

Ensured the Rate Chart screen scrolling capability, to accurately display the rate 
type availability with multiple pages.   

5.4.138 237860 

Enhanced the Additional Svcs screen that shows listing of all Spa Bookings, to 
ensure if Cancel Single Booking is selected on a Confirmed and Posted spa 
booking, the status of the booking will not update to Cancelled. 

5.4.138 239955 

Enhanced Rate Hurdle computation when changes are made on assigned Rate 
Hurdle.  Users will not have to log out and back in to see hurdle changes. 

5.4.138 240370 

Ensured upon new Client Profile creation, inclusion of manually entered figures in 
the Loyalty # field will save completely. 

5.4.139 240393 

Enhanced the Strenuous Housekeeping Rules when used to show Area rather 
than Credits in multiple screens.  Display screens affected are Housekeeping 
Assignment, Summary by Attendant, Assigned/Unassigned Rooms.  Room 
Attendants on Duty will now follow Property Specific if used during room 
assignment in a multi-property environment.  

5.4.142 

241746 
241750 
241753 
241759 

Ensured Rapid QAS (file exchange) can insert new state/province if the address 
query result does not exist in Maestro and update client profile appropriately.  

5.4.146 243731 

Ensured the search results display in a master and subgroup relationship. 5.4.145 244564 

Ensured in a multi-property environment, the assigned Housekeeping attendants 
are kept property specific during housekeeping auto assignment.  

5.4.146 243530 

Ensure dynamic template build with multiple night audit package components will 
breakdown based on setup. 

5.4.147 245831 

Ensured the batch check out on group reservation room list reservations as well as 
rapid check out process posts accurately to group master folio with charge routing 
in place. 

5.4.148 232663 

When reinstating a cancelled guest reservation, ensured the Charges/Verify under 
Guest Reservation will not allow previous assigned room number to be reinstated 
if not available. 

5.4.149 238403 

Ensured when overbooking is in place and overtyping a room type/number that is 
available, maestro will allow override and not show building not available 
message. 

5.4.149 246274 

Enhanced overbooking set up for a single day shows accurately on the quick 
availability chart. 

5.4.153 241155 

Enhanced client profile image upload to be compatible with 6-digit or more client 
codes. 

5.4.153 244906 

Ensured group reservation inventory is not doubling and released appropriately. 5.4.153 249959 
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Description Version Incident 

Enhanced Group reservation with Spa Bookings to use same Service Group 
Booking #. 

5.4.154 250447 

Enhanced Master and Sub groups inventory to allow sub groups to pull inventory 
from master rather than general inventory. 

5.4.158 242930 

Ensured during credit card entry dialog “Please complete guarantee and 
settlement before processing the card” displays in appropriate menu selections. 

5.4.155 251525 

Enhanced group spa bookings from group reservation, ensure correct screens are 
available and display of information is accurate. 

5.4.157 252173 

Enhanced front desk dashboard Check In and Check Out buttons to perform 
Rapid Check In and Rapid Check Out if in correct reservation status otherwise call 
up reservation correctly or receive an error message. 

5.4.159 251436 

Enhanced room statistics calculation when multiple inventory is booked with a rate 
type setup with night audit breakdown to show accurate room revenue. 

5.4.159 250951 

Group rooming list import with sharer reservations issued an array out of bounds 
Maestro Support error message. 

5.4.160 251515 

Ensured off market release time will effectively release when room is placed for 1- 
day off market and is prior to night audit start. 

5.4.160 252551 

Enhanced fast folio posting to validate posting code in multi-property environment 
and inform user with error if folio posting too belongs to another property. 

5.4.163 256717 

Ensured historical records for cancel reservations with multiple inventory reports 
correct room revenue for each line of inventory. 

5.4.163 256788 

Enhanced reservation with EMV credit card entry with “Payment” to post to next 
available open folio rather than first folio even if closed.  Also, do not allow posting 
to breakdown folios or folios with settlements that are setup with AR.  

5.4.164 
5.4.165 

257839 
259148 

Enhanced quick availability rate detail screen to show accurate taxes and amounts 
when rate types have seasons and or night audit package breakdowns are in 
place. 

5.4.165 
243019 
258488 

Ensured the group inventory releases based on system settings whether to allow 
stay outside of group block reservation dates.  

5.4.165 259498 

Enhanced cancellation process during a reservation creation that caused order of 
screens to populate with details that prevents a successful cancellation of the 
reservation appropriately. 

5.4.166 229346 

Ensured group with multiple priority rates display on all lookups. 5.4.167 245368 

Enhanced Housekeeping Services to display posted housekeeping charges. 5.4.167 262018 

Front Desk Dashboard was enhanced with speed improvements.  Reservations 
with No Inventory will now appear in the bottom right section called “No Inventory” 
with details available when Re-Calc Status button is selected and F5 drill down in 
the field.   
 

5.4.169 
5.4.171 

264613 
274883 
300146 

Ensured when in Client Extra Information screen if none of the fields are set to 
mandatory then user can enter through each field without it turning red and 
requires entry to exit screen. 

5.4.172 267805 
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Front Desk Report 

Description Version Incident  

NEW – Outstanding Group Balance Report has been enhanced to be multi 
properties. 

5.4.101 209302  
Access via: 
Front Desk> Reports Menu> Group Reports> Outstanding Group Balance 
Report>Window Menu> Property. 

NEW – Room Type Space Chart Report can now be export in CSV format.  Also, 
ensured the run of house ZZZ room types will show accurately. 
 
Access via: 
Front Desk> Reserve Menu> Room Type Space Chart> Print Chart (button). 

5.4.105 
5.4.172 

220174 
267329 

NEW – Daily Balance Audit Report has been enhanced, where it can be export in 
CSV format.  Same routine has been added to be part of Night Audit and 
Contingency Report Print sets. 

5.4.107 218166 

 
Access via: 
Front Desk> Audit Menu> Audit Reports>Daily Balance Audit Report and select the 
CSV button to complete export process. 

 
Configuration in: 
Global Maintenance> Report Menu> Night Audit Report Print 
Schedule/Contingency Report Print Schedule> Page down on Report Id until Daily 
Balance Audit Report> Window Menu>Report Print Commands>Window Menu> 
Import Fields Names and select Confirm to proceed> Look for a Field Name entry 
"CREATE_CSV"> Update Text Option to Y. 

NEW – Daily Balance Check Report has the ability to generate information for all 
properties in Multi Property environment.   

5.4.110 223543 Access via: 
Front Desk> Audit Menu> Audit Reports>Daily Balance Check Report >Window 
Menu>Property. 

NEW – Night Audit/Contingency Report Printing process for Guest Services 
Arrivals/Inhouse Report has been enhanced, to allow print command selection to 
have an option for all service codes. 

5.4.109 221633 

 
Configuration in: 
Global Maintenance> Report Menu> Night Audit Report Print 
Schedule/Contingency Report Print Schedule>Page down on Report Id until Guest 
Services Arrivals/Inhouse Report> Window Menu>Report Print 
Commands>Window Menu> Import Fields Names and select Confirm to proceed> 
Look for a Field Name entry "INCLUDE_ALL"> Update Text Option to Y. 

NEW – Group Billed Report now available in CSV format, and will outline actual 
charges including tax on folios for group members and group master. 

5.4.110 211939  
Access via: 
Front Desk> Reports Menu> Group Reports> Group Billed Report>Enter the 
desired group reservation number and select CSV to complete export process. 
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Description Version Incident  

NEW – Shift and Posting Audit report have been enhanced to allow user to control 
default value for Suppress Transfers. 
 
When starting to run the report, default set up as per global system option will place 
auto-defaults for Suppress Transfers. 
 
Configuration in: 
Global Maintenance>Setup Menu>Global System Options Maintenance> Page 
down to option 716 for Shift Report, update Data to Y or N; and option 717 for 
Posting Audit Report, update Data to Y or N. 

5.4.119 227654 

NEW – Guest Reports in Front Desk has been enhanced to include Guest 
Userfields Report, which allows user to pull a list of reservations that have the user 
defined fields filled out on client profile or reservation. 
 
Access via: 
Front Desk> Reports Menu> Guest Reports>Guest Userfields Report 

5.4.125 
5.4.133 

231127 
237835 

NEW – Enhanced Manager’s Revenue Report and Manager’s Dashboard reports, 
with capability to display forecast figures by posting codes and covers (by outlet).   

5.4.107 184659 

New columns added to report for budget numbers in the Month to date and Year to 
date. 

 
Configuration in: 
Forecast figure by type: Front Desk Maintenance >Setup Menu> Reporting 
Forecasts Maintenance>Lookup(F8) on Budget Type and select the desired 
category> Window Menu> Forecast Amount Range Entry>Select the desired date 
range and enter a valid (daily) figure on the Amount field. 
 
Forecast figure by Cover: Front Desk Maintenance >Setup Menu> Outlets/Covers 
Forecast Maintenance>Lookup(F8) on Outlet and Meal Period and select the  
desired options> Window Menu> Forecast Amount Range Entry>Select the desired 
date range and enter a valid (daily) figure on the Covers field. 
 
Forecast figure by Posting Code: Global Maintenance > Setup Menu> Posting 
Code Maintenance > Page down to the desired posting code>Window 
Menu>Forecasting>Enter the Yearly Amount. 

NEW – Group Billed Report has been enhanced with a new Package Breakdown 
column, when Include Breakdown option is set to Y. 

5.4.117 226523 

The Package Breakdown will include all details other than postings from room 
records, resort fee, and tax codes. 

 
Access via: 
Front Desk> Reports Menu> Group Reports> Group Billed Report> >Enter the 
desired group reservation and update Include Breakdown to Y. 

Improved Manager's Revenue Report generation process and now tabulates all 
past year revenue. 

5.4.117 191919 

Guest Count and Services Report under Guest Reports has been enhanced to 
accurately display service attached to reservations with multiple rooms. 

5.4.112 227672 

Market Segment Forecast report removed from all properties (designed for 1 
specific property only) 

5.4.120 215424 

Group Billed Report now will check validity of group reservation number entered 
before report is generated 

5.4.122 231819 
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Description Version Incident  

Cancellation and other crystal reports will now display GDS cancelled reservations 5.4.124 222922 

Credit Card Auth - Inhouse Report with Building code now displays correctly based 
on property level signed in with and building code selection  

5.4.125 228227 

Updated the Manager's Revenue report to running back as single property 5.4.124 231750 

Enhanced Clerk Reservations & Performance report, where report will now show 
Guest Reservations Reserved with no room inventory in the property that it was 
made.  Also, reservations that was created, cancelled and reinstated in the same 
date will show once, under the last reservation status.  As well as, the property 
report is ran for will display all associated reservations, including if reservation was 
started in property A and booked inventory for property B.  Ensured the note about 
text will display below its associated reservation.   

5.4.148 

211659, 
218971, 
244832, 
247288 

Enhanced the Redirected Printer to default when printing maestro reports and 
crystal reports.  Crystal reports using format of Crystal 8.5 with the following server 
versions were affected: 
 
Server Windows 2008; Server Windows 2012; Server Windows 2016; Server 
Windows 10 
 
- Please call Maestro Support for assistance. 

5.4.141 241902 

Forecast Rooms Report under Strenuous Housekeeping Rules set to a Y will not 
show number of credits. 

5.4.142 241742 

Ensured the Batch Registration Card Print will generate the batch forms even if 
there is a reservation with no inventory reserved and balance on folio for the arrival 
date the forms are printed for.  

5.4.143 243065 

Enhanced the Manger’s Revenue Report and Manager’s Dashboard Report to 
display the first/last day budget/forecast amounts. 

5.4.153 249543 

Enhanced the Proforma Consolidated Invoice when using housekeeping fee to 
accurately display on report. 

5.4.153 244089 

Ensured the Guest Userfields Report will show details of fields accurately on print 
and CSV reports. 

5.4.161 253936 

In a single property environment with GL codes setup, ensured the Manager’s 
Revenue Report will display all postings.   

5.4.164 247689 

Ensured rate type display is accurate on Inhouse Guest by Arrival Date report, 
when step inventory is in place on guest reservations.  

5.4.164 251937 

Enhanced Consolidated Proforma Report to show accurate charges when setup of 
Travels with, charge routing, and or charge posting is in place with Spa and Facility 
Bookings. 

5.4.165 257783 

Ensure Clerk Reservation and Performance Report shows number of nights 
correctly with variable package rates and anniversary post = N. 

5.4.166 260205 

Ensure Pro Forma Consolidated Invoice will show accurate tax amounts prior to 
charges being posted when charge routing rules are in place.  

5.4.172 264092 

NEW - Client profile Guest Report on all client activity to assist with compliance with 
Global Data Protection Regulation (GDPR) initiative. 
 
Access via: 
Front Desk > Profile menu > Client Profile > access client profile > Privacy menu > 
Guest Report 

5.4.157 252962 
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Accounts Receivable 

 

Description Version Incident  

A/R Shift Report has been enhanced to have the ability of export in CSV format. 

5.4.109 212824  
Access via: 
Accounts Receivable> Reports Menu>Select Shift Report> CSV is a newly added 
button for the export feature. 

A/R Aging Report has been enhanced to have the ability of export in CSV format 
and configured as part of Night Audit and Contingency Report Print sets. 

5.4.107 218750  
Access via: 
Accounts Receivable> Reports Menu> Select Aging Report>CSV is a newly added 
button for the export feature. 

Gift Card 
 

Description Version Incident  

The Gift Card selling process from Retail POS Module has been enhanced, if user 
Save/Exit (F4) from the Gift Card Swipe Screen without swipe or manual entry of 
Gift Card, the program will still follow activation procedure and post the funds 
accurately. 

5.4.125 229481 

 

Sales and Catering 
 

Description Version Incident  

NEW – Extended display for Booking lookup by Contact Name under Make/Edit 
Bookings screen, to allow booking contact to be viewed by Contact Name, Email 
Address, Phone Number, and Zip/Postal Code. 

5.4.110 221858 
 
Access via: 
Sales and Catering> Booking Menu> Make/Edit Bookings> Check Box for Include 
Past Bookings & Status ALL, enter first letter in Contact Name> Search> Booking 
Lookup By Contact Name appears with newly added detailed fields 

NEW – New Text Modifier for Inventory and Special Charge Items, to behave in the 
same fashion as the F&B Text modifier.  Once configured, user can copy the 
Inventory Item/Special Charge Text in the subevent during the booking process.  
Similarly, when duplicating a booking/event/subevent, if user select Y to copy the  
corresponding Modified text, they will be copied to the duplicated 
booking/event/subevent. 

5.4.112 
222060 
222062 

 
Configuration in: 
Sales and Catering Maintenance>Setup Menu>CASE Global Options> Allow 
Modified Inv Text and Allow Modified SPC Text is set to Y. 
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Description Version Incident  

Ensured accurate display of Room nights and ADR calculations on bookings that 
were copied from past bookings. 

5.4.114 222661 

Enhanced Client Trace, if all traces are marked as done, the client trace field on 
Client Profile/Sales and Catering Client Profile will be represented with "C" instead 
of N (no trace) 

5.4.117 224476 
 
Access via: 
Globally across all Client Profile Trace Message handling, for example: 
Sales and Catering> Client> SC Client Entry/View> Client Trace will now have the 
following representations: 
- 'n' is no traces; 'y' is undone traces present; 'c' -only completed traces are present. 

Enhanced Function Rooms, they can no longer be deleted once room has been 
used historically.  The intention is to preserve and prevent past and future bookings 
from being affected. 

5.4.122 226080 

Enhanced the Pro Forma Consolidated Invoice to accurately show postings, even if 
they transferred out from its original sales and catering folio to the group master 
folio. 

5.4.126 231445 

Enhanced the Booking Text and Billing Text on Sales and Catering Booking 
Template to respond accurately when drill down(F5). 

5.4.130 236884 

Merge capability has been enhanced to conform with date style of Date Month Year. 5.4.133 237793 

Ensured all filter functions while running Client Trace Summary Report will produce 
accurate results.  

5.4.149 247821 

Ensure Sales & Catering charges posted to Folio (in SC or FD) when transferred 
upto to 1 time will not be suppressed and will show on Pro Forma Consolidated 
Invoice report. 

5.4.162 251588 

Enhanced XML marker that sums Food and Beverage totals on merge contracts.  5.4.161 255370 

Ensured Shared Function Rooms, when changes are made dialog message 
appears “shared room” warns the user and allows changes successfully.   

5.4.174 
269160 
270096 

Enhanced Guest ADR calculation in a multi-property environment where blocks are 
across multiple properties. 

5.4.175 269942 

Spa and Activities 
 

Description Version Incident 

NEW – Allows the Participant name that is booked with group master name, to be 
overwritten with a guest name from within the group rooming list. 

5.4.110 
  

222626 
  

 
Configuration in: 
Spa and Activity Management Maintenance> Setup Menu> System Options> CM 
Guest on Rooming List is set to Y 
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Description Version Incident 

NEW – Maximum Daily Minutes has been added, it will allow restrictions to be place 
on Spa Services, that can be performed on daily basis by Service Provider. 
 
The setup for Maximum Daily Minutes is part of Service Provider Skill, that can be 
found under Spa and Activity Management Maintenance for each Spa Service.   

 
When booking a Spa Service, if the selected Service Provider has exceeded the  
daily maximum minutes, a pop-up message will alert user to select another 
Provider, and the booking cannot be completed until changes are made. 

 
Configuration in: 
Spa and Activity Management Maintenance> Service Menu> Select Service 
Provider Master> Page down on Provider Code to the desired Provider> Window 
Menu> Service Provider Skill> Update the DailyMaxMins column with desired 
minutes. 

5.4.129 
5.4.144 

212055 
243434 

Enhanced tax and gratuity display on Spa bookings. 5.4.114 225955 

Service by Day screen will now display Default Service Provider in the order of 
station number they have been setup with.  Similarly, Service Booking Entry will 
auto update service provider to the default service provider assigned to each 
station. 

5.4.116 226858 

Spa booking error message “Time is Outside of Spa Hour” will display when Spa 
booking are on at times outside of valid service hours. 

5.4.115 227034 

Service Booking Entry screen will now auto assign the next available station 
number without user intervention. 

5.4.116 226998 

Enhanced non EMV swiped credit card linked to client, with previous service history, 
can now be copied to new bookings. 

5.4.117 226848 

Spa booking entry enhanced, building code is a mandatory selection in multi 
property environment. 

5.4.117 228921 

Enhanced the folio display on spa gratuities to correctly show for group member 
folio with Charge Routing Rules. 

5.4.119 
222619 
229162 

Enhanced Spa Cancellation Policy to display the correct total if an Add On and 
Gratuity are part of the fee calculations. 

5.4.120 210448 

Enhanced Service Package bookings, if Substitution is allowed, the substituted 
service will update service rate and duration according to the service setup. 

5.4.124 230557 

Enhanced the cursor placement to follow Mandatory Fields on the Service Booking 
Entry screen. 

5.4.122 231461 

NEW – Professional Stock has been added to allow tracking of Back Bar used 
products, consumed over a user defined time period. 
 
All setups for Professional Stock are found under Spa and Activity Management 
Maintenance>Service drop down menu.  After defining the Item Unit Measurement 
(i.e. bottle, ML, etc.), Retail POS item can then be added to a Spa Service with a 
standard consumed amount, in units previously defined.   
 
There is a new dedicated menu for ProStock within Spa and Activity Management.  
Customizable periods are defined under Professional Stock Inventory Period with 
Start and End Date.   Similarly, the Start and End period count of Retail POS Items, 
for the period can also be entered with drill down(F5) on the date fields.   
 
 

5.4.127 
5.4.125 

230022 
 232182 
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Professional Stock continued… 

 
Once the period and count figures are entered, Professional Stock Variance and 
Professional Stock Forecast/Consumption are reports that can analyze variance of 
count VS expected consumption, and forecasting, on Back Bar products needed 
respectively. 

 
Configuration in: 
For Retail POS Item Unit Measurement 
Spa and Activity Management Maintenance> Service Menu>Item Unit of 
Measurement Codes> Create (F6) new measurement codes to be used (i.e. ml or 
oz, etc). 
 
Add Professional Stock for Spa Service 
Spa and Activity Management Maintenance> Service Menu> Select Service>Page 
Down on Serv Type the desired service> Window Menu>Professional Stock> 
Update out line with the Retail POS Item that will require an amount to perform this 
service for Pro Stock Feature.  Look up (F8) select Item Cate> Look up (F8) select 
Item, Description will default> enter Amount required for the usage of the spa 
service> Look up (F8) on Unit of Measurement to select. 
Addition of import button allows selected Service Type/ all Services, be batch import 
to a Service Room Number or Service Provider 
 
Access via:  
Spa and Activity Management Maintenance> Service Menu>Service Room 
Number> Page down on Building, and place cursor on the desired Room No> 
Window Menu> Room Service Allowed>Import(button). 
 
Spa and Activity Management Maintenance> Service Menu>Service Provider 
Master>Page down on Provider Code to desired provider> Window Menu>Select 
Service Provider Skill>Import(button). 

  

Description Version Incident 

When booking with Client Profile, who has no previous service history, the profile 
information For Quick Book section on all Spa booking screens will have consistent 
profile information.  It is now capable of keeping the Quick Books data on display 
while toggle between 5/12 rooms or 5/12 provider views on Service by Day and 
Providers Booking screens. 

5.4.130 
232920 
235976 
236066 

Complimentary Spa bookings (100% discount) with Gratuity and/or Add On Service 
will now trigger the settlement selection if folio has outstanding balance. 

5.4.130 231895 

Enhanced buttons on Spa Booking Entry screen to respond effectively. 5.4.130 235851 

Enhanced all ResWave integrated spa bookings, to send Maestro email with 
accurate booking information. 

5.4.130 236117 

Enhanced Spa booking screens to show the accurate toggle button description 
under the Quick book section. 

5.4.133 237491 

Ensure the auto service charge for hotel and provider will post using the unique 
posting code. 

5.4.130 235469 

Enhanced the Copy feature from the Providers Bookings screen, where if the 
Room+Building flag is set to Y, Maestro will attempt to find the next available 
treatment room if the intended room/station is not available. 

5.4.135 236892 

Ensured the Copy feature of Spa and Activities module in maestro web version will 
function correctly and not terminate the session. 

5.4.135 238600 
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Description Version Incident 

Ensured the default Hotel and Provider service charge will post with their 
respective, unique posting codes if setup. 

5.4.136 239469 

Ensured the Service Package booking will re-build and select the next available 
station when a package time changes. 

5.4.139 241125 

When spa service package is used, and the spa components are not setup to follow 
previous service, ensured Maestro will not auto update the following component’s 
guest time when the leading component guest time is modified. 

5.4.143 238595 

Ensured service booking can automatically pick the next available treatment room 
when time slot is occupied by room block. 

5.4.146 244083 

Ensured when rapid search for service group, after user drill down on search result 
and return to rapid search screen, the guest name on booking remain on display. 

5.4.146 244469 

Enhanced the spa booking when modify a spa package where components are not 
restricted to follow the previous service, user is able to move the component to 
time/room conflict with each other.  Now users will be alerted with error message if 
cannot complete the change when there is a conflict.  

5.4.147 244803 

Enhanced spa email markers to show accurate figures for Grand Total, Payment 
Received and Charge Fee. 

5.4.149 248390 

Enhanced group spa bookings, when front desk res # is removed it will also remove 
the spa group number. 

5.4.155 252104 

Enhanced provider booking screen to display spa blocks a different colour. 5.4.157 252418 

Ensured when Recur Rapid Function is used to book reoccurring spa bookings, 
maestro will not allow overlapping bookings.  

5.4.161 251186 

Ensured when Swap Rapid Function is used to allow swap to available 
room/stations, otherwise if not available, do not complete swap. 

5.4.161 255315 

Enhanced the Spa Booking – Batch Process to not encounter an ODBC error.  5.4.165 259352 

Enhanced the Full Day Services by Day and Full Day Providers Bookings screen to 
show entire day with Time Intervals appropriately  

5.4.165 259480 

Enhanced Service Provider Schedule, when adding setup for default room, can exit 
screen easily. 

5.4.166 260195 

Ensured same client code for spa booking and facility booking can be used as long 
as activity or treatment do not overlap. 

5.4.167 261372 

Ensured spa itinerary section of the email confirmation will show all spa and facility 
bookings if there are multiple bookings in a day for the guest name and or additional 
name of the attached front desk guest reservation.  

5.4.175 268554 

Facility 
 

Description Version Incident  

NEW – Facility Booking Activity Log is now available on Booking Entry screen.     

Facility Blocking screen has been enhanced to allow more entries to be configured. 5.4.114 223844 

Booking Entry screen has been enhanced, where quantity and availability will 
update in a timely manner.  Same change has also been applied to Email 
Messages. 

5.4.116 221559 
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Description Version Incident  

Corrected Discount error message with proper spelling. 5.4.130 236123 

Enhanced Facility Availability, and Booking Information and Summary displays, if a 
facility block exists, the effected date/time ranges will not appear on either screen. 

5.4.130 236254 

Enhanced Facility Instructor assignment process, if user attempt to assign Instructor 
to class times that conflict with Instructor Time Block, the Facility Instructor will not 
appear as a candidate for assignments. 

5.4.130 236259 

Ensure accurate client profile age, height and weight is displayed in Facility Booking 
and Facility Booking Info and Summary Screens. 

5.4.165 258947 

Ensured facility booking with a zero rate will show Quantity and Participant Name 
with or without client code accurately when retrieved from Rapid Search – Guest, 
Rapid Search – Facility, and Facility Inquiry screens.  Also, ensured Client Code is 
passed to Facility Booking entry screen. 

5.4.172 
267007 
268301 

 

Member 

 

Description Version Incident  

NEW – Member Card can now be enter/swiped in formats that do not adhere to 
Maestro Member Card Rules (i.e. begins with 32208 follows by Member Card 
Number) 
 
In order to activate this new Feature, Global System Option 725 need to be Y, then 
Maestro will accept all Member Card swiped/entered.  The Swiped/enter value will 
appear on Member Card screen under Member Profile 

5.4.125 232378 

 
Configuration in: 
Global Maintenance> Setup Menu>Global System Options Maintenance> 725 is set 
to Y 

NEW – When EFT is setup for Direct Debit File ONLY, new option to replace 
Maestro Member Profile number with Account Number in the EFT export.  For the 
same EFT setup, EFT file now contains customizable values to indicate new and 
existing EFT Members 
 
This New feature only applies to EFT setup in the format of Direct Debit File Only, 
and the values will appear on the EFT export, based on setup.   
 
If Global System Option 729 is set to Y, then Maestro will use Member Account 
number in place of the Maestro Member Profile number in the EFT export, if 
Member Account is present.  User also has the ability to customize two numerical 
values that represent new and existing member profile to EFT function. 

5.4.126 233525 

 
Configuration in: 
Allow Member Account Number in EFT 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to 729 and update Data to Y. 
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EFT Direct Debit continued… 

 
Indicator of New and Existing Members that uses EFT 
Spa and Activity Management Maintenance> Setup Menu>Member Setup>Select 
Banking Information Setup>Enter numeric figure (up to 2 digits integer) to represent 
EFT Code for new and existing members. 
 
Values also can be entered on 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to option 730 for New, 731 for existing, and update the numerical values. 

Description Version Incident 

In a multi property environment, Spa POS interface has been enhanced to check for 
which property member profile belongs to.  It will create a new Member folio when it 
detects the member profile resides in a different property. 

5.4.126 234122 

Enhanced Credit Card screen handling under Member Profile. 5.4.129 235259 

Enhanced SSL certificate handling. 5.4.120 230198 

Default Member Folio Type to "All Folio Types" (*) on Member Aging Report and 
Legacy Member Statement. 

5.4.119 229251 

Ensured Member Statements Print and Email functions are consistent for batch and 
individual members. 

5.4.125 
5.4.142 
5.4.149 

229288 
239615 
247819 

Enhanced member join and expiry date to validate entry.  Before if entered an 
invalid date caused an ODBC error and crash of program. 

5.4.153 248849 

Ensured during member statement email display log is present at all times. 5.4.154 
250935 
251340 

Enhanced Membership Reporting to display total number of members at bottom of 
report. 

5.4.161 255058 

Enhanced Secondary Member fields to auto sync with Primary Member setup upon 
changes.  Lock fields based on Member Status and unlock Join/Expiry Date on 
secondary members.  

5.4.161 255193 

NEW – (R)eport (Fix) Secondary Member Profiles to update secondary profiles with 
setup details matching with primary member profiles.  Fields that should be synced 
from Primary to Secondary include: Member Status, Account Number, Member 
Type Code, Member Group, Discount Type, Minimum Code, Credit Limit, Late 
Payments, Daily Statements, Invoice Copies, Automatic Apply.  The Join/Expiry 
Date may also update only if Secondary Member Join and Expiry Date is blank, 
otherwise each profile is unique.  The Fix will always take the Primary Setup and 
copy over to Secondary member profiles.  Report mode will provide member 
profiles that will be affected before running the Fix mode. 
 
Access via: 
Global Maintenance > System > Support > Fix Secondary Member Profiles.   

5.4.163 257219 

Ensured Member EFT process will distribute to secondary member balance 
accounts if needed to balance and close folios.  

5.4.167 259707 
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Owner 
 

Description Version Incident  

NEW – "Owner Lookup for Room" available on six Room Number Chart from 
Window drop down menu to display past, current, and future Owners of an unit. 

5.4.101 209237 

 
Access via: 
Room Number Space Chart (Front Desk> Reserve Menu). 
Room Number 2-week Tape Chart (Front Desk> Reserve Menu). 
Room Number Tape Chart (Front Desk> Reserve Menu). 
Room Number Space Chart by Room Number (Front Desk> Reserve Menu). 
Who has Room Booked List (Room Number Space Chart>select date on row of 
room type> look up (F8)). 
Assigned Rooms/Rates (Guest Reservation> Inventory> Assignment 
Chart>Window). 

Enhanced owner statement can still be exported in HTML format to support third 
party owner statement upload. 

5.4.112 228843 

Enhanced Owner Reservation Commission calculation, when a specific rate type 
is configured, will ensure commission calculation is computed based on the 
dedicated rate type. 

 5.4.124  231243 

Enhanced Owner Statement CSV Summary Generation will export consolidate 
owner statement based on selection. 

5.4.130 235759 

Enhanced the Owner Reservation by Interval, displays Timeshare Owners with 
multiple weeks of ownership accurately and smoothly. 

5.4.130 235756 

Enhanced when selling owner unit with the Sell Owner Unit feature, Maestro will 
properly update Percentage Owned on both the buying and selling Owner 
Profiles. 

5.4.130 236109  
Access via: 
Owner Management>Owner Profile Menu> Page Down or look up (F8) current 
owner profile> Window Menu>Owner Units>Window Menu>Sell Owner Unit. 

Enhanced the Timeshare/Condo Stay History will display Room Revenue 
accurately. 

5.4.124 229527 
 
Access via: 
Owner Management> Owner Profile Menu> Page down or lookup (F8) on Owner 
Profile to search by criteria> Once on the desired Owner Profile, select Reserve 
Menu> Display Unit Stay History. 

Owner ResWave "View Unit Reservation" has been enhanced, so that non-
owner reservation will not display guest name. 

5.4.128 229071 

Enhanced owner reservation commission calculation, when a reservation service 
charge fee is configured for rate type, guest type or length of stay. 

5.4.138 239963 

Enhanced Service Charge setup to process and split the charge amongst 
multiple owners on the same unit instead of posting full amount on each owner 
of the unit. 

5.4.150 224083 
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Description Version Incident 

Enhanced owner reservation commission calculation to compute correctly with 
only room records setup. 

5.4.159 253490 

Enhanced Owner ResWave Owner Reservations display to show list of 
reservations that are assigned to unit and Last Name will display “Guest” or 
“Last Name” of each listing depending on the global system option selection. 
 
Configuration in: 
Owner Management Maintenance> Setup Menu>Global Setup> Owner Portal 
name by (C)lient or (G)uest Type 
C = Client Code, where only reservations that match the owner client code, Last 
Name will appear.  All other reservations will display as “Guest”. 
G = Guest Type, where only reservations that match the owner guest type, Last 
name will appear.  All other reservations will display as “Guest”.  

5.4.178 
299660 
300711 

Work Order 
 

Description Version Incident  

NEW – Ability to force the user to configure billing details on where the charges 
should be posted for the work order. 
 
If Global System Option 722 is set to a Y, this will prompt a warning for the user to 
confirm the Bill To owner, member or accounts receivable account. 

5.4.121 228516 
 
Access via: 
Global Maintenance> Setup Menu>Global System Options Maintenance> Page 
down to Option 722> under Option Data enter Y>then save/exit (F4); if the Global 
System Option 722 Option Data is set to N, then set up as per Work Order 
Maintenance> Setup Menu> Global Setup bottom right section shows "Allow to 
bill…" details and it will be used to bill work orders 

Enhanced the ability to update the status of the work order to "Closed" prior to a 
completion date is entered. 

5.4.119 
  

224632 
  

 
Configuration in: 
Work Order Maintenance> Setup Menu> Progress> When Work Order Closed = 
Status as per what is considered as closed status (property specific) 

Enhanced the wording of pop up messages during billing process, it will not display 
"Bill to owner" that may be misleading if a member or accounts receivable is 
configured to bill to. 

5.4.121 229217 

Enhanced the bill work order to owner’s accounts, if configuration on the owner 
profile charge work order =N then user will be prompt with warning to double check 
billing and change bill to recipient. 

5.4.126 231468 

Enhanced the Work Order Cost report, it will display building code accurately. 5.4.130 235785 

Enhanced the Work Order batch report to select building code. 5.4.130 236001 

Work order billing enhanced to use manual entry of time spent or material costs 
when chargeable items configuration is not used.  Allows users to mark costs for 
Hourly or Flat rates along with option for Material costs that will show in work order, 
however will not post to a receiving account. 

5.4.139 235734 
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Retail POS 
 

Description Version Incident  

Enhanced Retail POS folio screen is capable of displaying all transactions up until 
the current audit date. 

5.4.116 227527 

Added Item Code Description to Retail POS Provider Commissions Report. 
 
Access via: 
Retail POS> Reports Menu> Provider Commission Report. 

541192 181659 

Enhanced the Item Maintenance screen to allow search by item code or item 
description. 

541192 181663 

Enhanced scrolling within the Inventory Query with selected outlets that have more 
than 1 page of items listed. 

5.4.130 235708 

Ensured receipt print marker for total amount charged prints accurately. 5.4.162 256806 

Enhanced POS settlement screen to not post anything until payment method is 
selected and processed successfully, otherwise cancel transaction appropriately. 

5.4.166 259891 

Loyalty 
 

Description Version Incident  

Enhanced Loyalty Program, where Loyalty Points availability can now be controlled 
in Loyalty Setup Options. 

5.4.124 219263 

To reduce fraud, the "Points Avail After C/O" field has been updated to accept 
numeric value (measured in days), instead of Y/N value.  It accepts figures from 0 to 
99 where:   
0 = Loyalty Points available immediately 
1 = Loyalty Points available 1 day after check out   
2 = Loyalty Points available 2 days after check out and etc... 

 
Configuration in: 
Global Maintenance> Codes Menu>Loyalty Program Setup>Loyalty Setup 
Options>update Points Avail After C/O with a numerical value. 

Ensured Loyalty configured Service Codes are generated on guest reservations 
when using a rate type with preconfigured source and sub source of business. 

5.4.146 240556 
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Global Maintenance 
 

Description Version Incident  

NEW – Ability to access ELEARNING QRG documents from corresponding Maestro 
screens given live.ini file is setup. 

5.4.112 224240 

On each Maestro screen, there is a new Learning Materials section under the Help 
drop down menu.  Corresponding documents related the active Maestro screen will 
be listed. 

 
Configuration in: 
workstation ini file or server ini file - Please contact Maestro Support for 
assistance. 
application "c:\program files\internet explorer\iexplore.exe" 
URL http://elearning.maestropms.com/ 

NEW – Credit Card Entry by EMV Only has been enhanced to ensure when 
activated (Global System Option 696 is set to y), user will not be able to manually 
enter credit card in Maestro. 

5.4.119 228907  
Configuration in: 
Global Maintenance>Setup Menu> Global System Options Maintenance> Page 
down to System option 696 and update Data to Y. 

Printing Reports from Maestro Web has been enhanced to follow the date format as 
per configuration in ini file. 

5.4.116 227827 

Enhanced cache accuracy on posting code with property restrictions. 
5.4.119 
5.4.124 

228336 
232416 

When using a Cancellation/Modification Policy, the configured currency symbol 
displays on prompt to continue with policy.   

5.4.102 188631  
Configuration in: 
Global Maintenance>Setup Menu>Global System Options Maintenance>Page 
down to System Option 586, update Data to the desired currency symbol. 

Implemented new locking mechanism, which enhance experience for multiple users 
accessing/updating, the same information on the same screen at the same time. 

5.4.128 227307 

Enhanced Fusebox configuration in Maestro to follow Fusebox protocol. 5.4.118 228889 

Enhanced new locking mechanism to remove old locks. 5.4.128 229436 

Expand the number of properties allow on display when lookup (F8) on Property 
Code in Hotels-Properties. 

5.4.128 231448  
Access via: 
Global Maintenance>Codes Menu>Hotels-Properties >Lookup(F8) on Property 
Code field. 

Enhanced the mandatory field requirements within Client profile>Client Extra 
Information screen. 

5.4.132 234384 

When post check in email is configured, enhanced the email interface process to 
send emails effectively.  Also, during night audit built of emails, they will remain until 
time to send out upon reservation Inhouse status and post check in time. 

5.4.133 
237362 
238383 

Ensured tax code that are setup with tax modifier will display the tax amount 
correctly on assignment chart, email, proforma report. 

5.4.143 242806 
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Description Version Incident 

Enhanced the Generate Email function that will produce emails using language 
specific setup.  

5.4.149 248019 

Enhanced trace message purge to follow parameters 5.4.153 246543 

NEW- Global system option 740 set to a ‘N’ added for the ability to represent 
covered privilege amounts in the email confirmation as a visual of included privilege 
amounts on package reconciliation rate types. 
 
Configuration in: 
email markers <em.guest.total_tax_no_wait> & <em_guest.total_tax_no_fee> - 
Please contact Maestro Support for assistance. 

5.4.154 250429 

Enhanced GEM post stay email to generate and send out when using language 
specific setup 

5.4.158 248548 

Ensured global system option 20 will correctly adhere to yields with consideration of 
stay through dates.  

5.4.155 249231 

Enhanced the industry card type for DI (Discover) with Fusebox (Elavon).  5.4.155 250883 

Ensured tax modifiers are following individual tax codes and appropriate lengths of 
stay as well as backdate configurations.  Also, in multi-property environment, the 
reservation inventory property will be used to post tax audit adjustments rather than 
use audit property code. 

5.4.160 
5.4.163 
5.4.167 

252830 
257977 
259094 

Ensured that room number deletion is prevented if reservation has used this room 
number. Please contact Maestro Support for assistance. 

5.4.160 253943 

 

ResWave 
 

Description Version Incident  

Enhanced the ResWave Group management, a convener has the ability to 
edit/modify/cancel rooming list reservations, maestro will receive and update 
reservation details. 

5.4.120 229665 

 
Configuration in: 
Group reservation> Window Menu> Web Rooming List Access Permission> add 
entry for Email Address, UpdAld (Update Allowed where Y = View & Edit/Remove 
and N= View Only) 
 
For Group Convenor Access Via: 
https://www.reseze.net/servlet/SendPage?page=signIn&skipfirstpage&hotelid="Hot
el ResWave ID" 

Enhanced caching in maestro suites. 5.4.117 228503 

Enhanced the advance deposit requirement due, in the case of multiple advance 
deposit collection is in place. 

5.4.120 228504 

Enhanced booking of Other Charges specific to the date booked. 5.4.120 230315 
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Description Version Incident 

Enhanced the ability to enter detailed description about the rate type within Web 
Rate Type Text fields.  Added the ability for the web rate type text to be property 
specific and work with rate seasons. 
 
Configuration in: 
Front Desk Maintenance> Interface Menu> CRS/WEB Interface Setup> ResWave> 
Window Menu> Property> Select Property> Window Menu> Web Rate Type> 
Select Rate Type> Window Menu> Web Rate Type Text Maintenance 

5.4.120 
228140, 
228256, 
230309 

Enhanced the rate type description display if booking is crossing over multiple 
seasons, will use first rate type season description to display. 

5.4.125 230556 

Enhanced Group member reservations that generates a modified email confirmation 
will now show true updated reservation changes. 

5.4.118 228262 

For Group member reservation, can now use the View/Modify/Cancel to access 
reservation details on ResWave. 

5.4.120 228396 

Enhanced the booking of maestro suites, next available suite can be booked without 
errors. 

5.4.126 233429 

Enhanced the page display return message when "Room is Not Available" on a 
booking query. 

5.4.124 232547 

Enhanced the ResWave Spa and Facility Web Setup in multi property environment 
(with different ResWave instances), to display the Spa Services and Facility 
Activities according to the building selected. 

5.4.136 236987 

Enhanced ResWave Group name display to show 50 characters, same as Client 
Profile. 

5.4.140 122754 

Enhanced ResWave to assign the next available provider to spa booking when the 
Maximum Daily Minutes are configured to services. 

5.4.143 242617 

Ensured spa building and other spa setup screens are displaying configuration in a 
multi-property multiple instance reswave environment. 

5.4.144 243688 

Ensured spa provider with no gender setup can display appropriate availability. 5.4.146 244030 

Enhanced ResWave display sort to include 2 new options of: 
B: Room Type Group > Amount with Rate Type > Room Type 
C: Amount with Rate Type > Room Type Group > Room Type 

5.4.154 250349 

Ensured the rate display matches details pop-up link when using yields. 5.4.157 252339 

Ensured in a multi-property environment with consolidated ResWave setup, 
confirmation text will show accurately within the confirmation email marker as per 
property set up. 

5.4.159 252456 

Ensured all Spa Service types will upload correctly even if some Services between 
listings in ResWave setup are missing complete Service setup from Spa side. 

5.4.172 268763 

Ensured maestro suite types will show correct availability on ResWave when setup 
to display/not display room numbers.  

5.4.177 272581 
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Maestro Web 
 

Description Version Incident  

NEW – Added new parameter where the maximum number of pages on a single 
report print can be controlled.  If report size exceeds page limit, a warning message 
will populate, and the report will not generate. 

5.4.129 235250  
Configuration in: 
Config.xml, <maxMaestroReportPages>"enter max page number here" 
</maxMaestroReportPages> - Please call Maestro Support for assistance. 

Description Version Incident 

NEW – Added new parameter to allow control on the length of inactive time for 
Maestro to terminate a web session.  Once a web session had reach the designated 
period of inactivity, Maestro will automatically terminate the session and user will 
see warning message "Maestro Program Terminated on Server". 
 
Configuration in: 
Config.xml,  
<purgeMemListDuration>”enter time here”</purgeMemListDuration> 
<purgeIdleSessionDuration>"enter time here" </purgeIdleSessionDuration> 
<idleSessionTerminateDuration>"enter time here" </idleSessionTerminateDuration> 
- Please call Maestro Support for assistance. 
Time can be expressed in - Hours ##h, or Minutes ##m, or Seconds ##s 

5.4.129 235447 

Ensured odtTemp directory file is part of the Maestro Web Build. 5.4.144 243303 

Ensured dates in multiple maestro screens will not default to 00/00/00#0, including 
Additional Names DOB, Personal Information DOB, and Work Order Inspection and 
Completion date to name a few. 

5.4.177 269772 

Maestro Mobile App 
 

Description Version Incident  

NEW – Mobile Digital Signature App, will allow signature capture and retrieval on a 
mobile device or web browser, where registration card can be signed/retrieved 
based on signed date range or reservation number. 5.4.097 210421 
Setup is a schedule task, where digital registration card can be customized based 
on property needs.  Please call Maestro Support for assistance. 

Enhanced Guest Reservation Activity Log, under Guest Reservation in Front Desk.  
When Maestro user log into Mobile Digital Signature App for Registration Card 
Retrieval, it will maintain the clerk information as the specified Maestro user that is 
designated to run the service. 

5.4.100 206001  
Configuration in: 
Workstation ini or server ini file - Please call Maestro Support for assistance. 
[pcservicesserver] 
user   pcserve 

Enhanced check in routine for Credit Card authorization process, where proper 
response is send back to vendor when credit card is declined. 

5.4.121 230345 
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Description Version Incident  

Enhanced both Housekeeping and Digital Signature Mobile Apps on Menu and 
Button placements. 

5.4.129 234881 

Webpro mobile app has been enhanced to ensure the Private Transportation details 
transition into Maestro accurately. 

5.4.129 232794 

Housekeeping mobile app has been enhanced to ensure service codes display 
within the details page of the room number. 

5.4.129 
234997 
236030 

Folio mobile app has been enhanced to support bilingual text display. 
 
Configuration in: 
Mobile app HTML Templates Folder -  Please call Maestro Support for 
assistance.  

5.4.136 237354 

Enhanced Payment Portal to show an error when no email address is entered on 
first page of maestro app to proceed with processing a payment. 

5.4.160 251170 

Interfaces 
 

Description Version Incident  

NEW – Maestro can now integrate with Experian on-line address lookup, as an 
alternative to the rapid QAS functionality. 
 
Configuration in: 
Purchase Service Package with Experian QAS Address Verification 
Please call Maestro Support for assistance on setup. 

5.4.126 229824 

NEW – Hitachi interface has been enhanced to include new option to turn off LRC 
checking. 

5.4.126 234065  
Configuration in: 
Front Desk Maintenance> Interface Menu>PBX Interfaces Setup>Select Hitachi> 
Update Tty LRC Checking to N. 

PXP Credit Card interface had been enhanced to send proper link transaction 
values. 

5.4.122 231630 

Credit Card Pin Pad Devices setup in Global Maintenance has been enhanced to 
accept ports up to five digits in length. 

5.4.124 231961 

Genomi interface has been enhanced to group historical information into monthly 
packets, and upload, to prevent information overload for vendor. 

5.4.126 233819 

Speed improvement on Rainmaker/Duetto interface. 5.4.126 233922 

General Ledger Export has been enhanced to allow Statistic exports be send 
separately to all selected recipients by property. 

5.4.130 
5.4.133 
5.4.142 

213973 
238361 
242611 

 
Configuration in: 
Front Desk Maintenance> Interface Menu>Data Import/Export Interfaces Setup> 
General Ledger Export Setup> update Export Statistics To Separate File to Y. 
 
Front Desk Maintenance> Interface Menu>Data Import/Export Interfaces 
Setup>General Ledger Export Setup> Window Menu>Email Setup>Update Email 
Address with desired recipients> Window Menu > Property> Switch to another 
Property to setup unique recipient, each recipient will only receive exports for the 
property they are setup with. 
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Description Version Incident 

For Shift4 credit card interface, when credit card holder does not respond to the 
signature prompt on the EMV device, and credit card transaction reviewed approval 
for transaction value, Maestro will follow Shift4 protocol. 

5.4.130 
236159  
231016 

TTI scanner interface has been enhanced to prevent crash in the image test or on 
Client Profile. 

5.4.116 203968 

Enhanced Fusebox protocols with non- EVM credit card swipe capture. 5.4.133 237682 

Enhanced logging protocols for POS interface service. 5.4.133 238369 

Enhanced GDS interface to upload rate/yield/hurdle changes in timely manner.  
5.4.133 
5.4.136 

236849 
234006 
239304 

Enhance Maestro GDS interface to integrate IATA information from SiteMinder 
reservation message. 

5.4.130 235575 

Enhanced GDS interface upload messages to follow flag for “Rates are Tax 
Inclusive”. 

5.4.174 269029 

Enhanced Delphi interface to not double encode the “Request” elements.  Send 
information in correct date format and send group member pick up in a timely 
manner.  Also, ensured the interface does not drop pickup for past days. 

5.4.133 
5.4.136 
5.4.149 

235654 
239310 
239478 
248558 

Enhanced Fusebox response messages when partial approvals and partial 
payments are received back, as well as posted to folio. 

5.4.138 237004 

Enhanced Fusebox response messages to show all decline messages. 5.4.138 235310 

Rainmaker Revenue Management interface enhanced to use https protocol 
integration.  

5.4.137 
5.4.139 

240130 
240427 

Ensured Group Master reservation records are built before sending out to Revenue 
Management interfaces mainly for Duetto, Rainmaker or iDeas. 

5.4.139 238983 

Enhanced Travel Tripper GDS interface with tags for Source of Business to migrate 
into maestro successfully when configured. 

5.4.139 240555 

Enhanced Synxis interface message files to use description “AmountAfterTax” when 
inclusive or VAT tax setup is in place. 
 
Configuration in: 
Front Desk Maintenance> Interface> CRS/WEB Interface Setup…> GDS Two-
Way> Page down to valid GDS Instance> enter a Y in Rates are Tax Inclusive  

5.4.139 240766 

Enhanced Fuel Interactive and Synxis GDS interface to handle Other Charges. 5.4.140 
240767 
241710 

Ensured when using the Experian QAS interface, the insertion of a new State or 
Province will update in maestro as well as if no results, a message appears “No 
Matches Found”.  Also, enhanced when setup is incorrect no error message “QAS 
INIT failed” will appear and prevent exit from client profile screen. 

5.4.140 
5.4.149 

240783 
248067 

Squirrel POS interface was enhanced to respond with message when clerk looks up 
a guest and the look up fails. 

5.4.139 241034 
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Description Version Incident 

Ensured Siteminder GDS interface reservation migrations into maestro will keep 
“Set By” flag as N on Credit Cards when configuration for Use CC for Settlement is 
set to a N. 
 
Configuration in: 
Front Desk Maintenance> Interface> CRS/WEB Interface Setup…> GDS Two-
Way> Page down to valid GDS Instance> Use CC for Settlement is set to a N. 

5.4.142 241861 

Enhanced Travel Click GDS interface with group reservations that migrate into 
maestro, source and sub source of business will auto fill if configured. 
 
Configuration in: 
Front Desk Maintenance> Setup> Group Master to Group Members> Copy Source / 
Sub Source is set to a Y 

5.4.142 242031 

Enhanced credit card handling with Shift 4 processor where after assigning pin pad, 
select credit card type, hit cancel on EMV device (credit card was not entered in 
EMV device), maestro will NOT post to folio or capture a blank masked credit card. 

5.4.144 243467 

Enhanced Shift 4 processor messages to include guest name and reservation 
number to be sent when manual entry of credit card is entered to reservation while 
no EMV device is being used. 

5.4.146 232035 

Ensured PXP processor sends manually entered credit card entry payment and 
authorizations as “mail order” instead of “keyed”.  Also, correct display the voucher 
field when received response from processor. 

5.4.148 
5.4.154 

247310 
250914 

Enhanced Fusebox processor with ability to use processing device for manual entry 
of credit cards.  Now will be able to use “EMV – Keyed Entry” or “EMV-Chip or 
Swipe” options. 

5.4.154 244117 

Enhanced Shift 4 processor for manually entered credit cards with AVS/CVV 
numbers entered, when authorise / post payment log shows “Keyed” not “Swiped”. 

5.4.154 250179 

Enhanced display authorization screen to show accurate credit card type when 
using Shift 4 processor and swiping incorrectly chosen card type in EMV device. 

5.4.158 247702 

POS posting error when the check has exceeded maestro limit during posting. 5.4.158 253460 

Enhanced Shift 4 processor with Debit Card entry, when folio posting code is Debit 
Card then retain original posting code and not get error message. 

5.4.160 253515 

PMS Connect GDS interface requires group reservation to send last stay date 
rather than departure date. 

5.4.163 253207 

Enhanced GDS interface to include Cipher Key. 5.4.164 257852 

Ensured GDS interface reservations migrate with inventory when “GDS availability 
overrides hotel availability”  

5.4.165 259281 

Enhanced Sonifi movie interface to process express checkout messages. 5.4.165 259297 

Enhanced credit card encryption when returned from Fusebox credit card 
processor. 

5.4.165 259309 

Ensure POS interface can post to Sales & Catering Folio. 
 
Configuration in: 
Global Maintenance>Setup Menu> Global System Options Maintenance> Page 
down to System option 753 and update Data to Y 

5.4.166 260721 

Enhanced Experian QAS to allow display of picklist with more than 200 characters. 5.4.167 261983 
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Crystal Report 
 

Description Version Incident  

NEW – Maestro now has the ability to export Crystal reports that are setup with "X" 
on the Preview column.  Once configured, user will be able to choose from five 
types of export format - PDF, CSV, EXCEL, WORD, RTF.  This is applicable to all 
Crystal Reports across all modules. 

5.4.117 227076 

 
Configuration in: 
Global Maintenance> Report Menu> Other Reports File Maintenance or Other 
Reports File Maintenance (NoCat)>Select the desired crystal report, enter "X" in the 
preview column. 
 
Global Maintenance> System Menu>User Forms Maintenance> update the View 
field with "X" on desired crystal report. 
 
Front Desk Maintenance> Forms Menu> Crystal Report Defaults> enter "X" in the 
Preview column on the desired crystal report. 
 
(All modules Third-Party Reports Defaults - Please call Maestro Support for 
assistance). 

Reservations By Room Number report has been enhanced to include Grand Total 
by room number for the report period.  In addition to total revenue, total number of 
reservations and room nights will also be display in a summarized format. 
 
Report Name: resByRoomCode.rpt 

5.4.130   

Sales and Catering Contact report has been enhanced, it will now display an 
additional prompt to allow report to include/exclude Inactive client contacts. 
 
Report Name: sccontact.rpt 

  237162 

Daily Schedule report has been enhanced to show the status of the booking when 
listed in Sales and Catering. 
 
Report Name: dailyschd.rpt 

 239004 

Facilities report is now enhanced with criteria if asked to include email address the 
report will now display the participants email address.  
 
Report Name: facilities.rpt 

 239817 

Sales and Catering Contact report has been enhanced to include parameter to 
select a state/province. 
 
Report Name: SCContacts_allcon.rpt & SCContacts.rpt 

 240369 

Member Profile List has been enhanced to include member minimum code. 
 
Report Name: cm_memprofile.rpt 

 241066 

Reservation Activity Log has been enhanced to include parameter to select a clerk 
code. 
 
Report Name:reservationActivity.rpt 

 241048 

Group Roster Report has been enhanced to include event name. 
 
Report Name:grproster2013.rpt 

 242792 
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Description Version Incident 

Groups with No Cut-offs report has been enhanced to display group information on 
the selected property when specifically entered. 
 
Report Name:noCutoff.rpt 

 244880 

Group cutoff report enhanced to exclude group reservations that do not have a 
building code or block records for the property running the report. 
 
Report Name: cutoffs.rpt 

 256316 

 

QlikView/Analytics 
 

Description Version Incident  

Enhanced the Analytics views that is using database table where the other 
charges bucket will accurately show other charges amounts booked and posted.  

5.4.153 231851 

Description 
Date 

Modified 
Incident 

Marketing54.xml.qvw was enhanced with group master and group member 
reservation details to display accurately on the Additional Selections Tab.  
Reservations Selection Tab now displays the Stay Date Year correctly.  

01/24/2018 
239557 
239763 

Marketing54.xml.qvw enhanced to show Total Revenue where before, it was only 
showing total room revenue on the Reservation Selections> Yellow display box 
section.  

01/26/2018 239763 

Description 
Date 

Modified 
Incident  

Sale&Catering53.qvw was enhanced, where the Pipeline report under the 
Pipeline tab will now display the cumulative total on the number of guest column 
when the view is collapsed. 

01/30/2018 240107 

Sales&Catering54.qvw was enhanced with addition of client code to the Email 
List under the Mailing Lists tab.  Also, the ADR was added to the Confirmed 
Booking Guest Rooms Report under the Pipeline tab. 

02/01/2018 240358 

Description 
Date 

Modified 
Incident 

Stats53.qvw was enhanced with addition of Group tab 02/02/2018 239830 

Description 
Date 
Modified 

Incident 

BigPicture53_xml.qvw was enhanced on the Big Picture tab to include Billing 
Client.  

02/20/2018 232686 
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Incidents Pending Resolution 
 

Description 
Reported 
Version 

Incident  

Front Desk   

Front Desk Dashboard was enhanced with speed improvements.  Fields in bottom 
right in Re-Calc Status section specifically for VIP Inhouse/Arrng, Cutoff Groups, 
No Inventory and Unassigned, when drill down on the fields, are not populating a 
list of detailed reservations affected in each respective category. 

5.4.168 
264613 
274883 
300146 

Booking Facility from a front desk reservation or in Facility Availability, when in 
Booking Information and Summary screen, type in a guest name that is not 
associated with client code and enter through, the participant name does not get 
passed to Facility booking screen.  Occurs in setup for facility type and code have 
default and guest rates, however the Weekly schedule has no guest type defined.   

5.4.168 269353 

Ensure all Meal Reports in Front Desk Module will display meal plans for guest 
reservations with step inventories, where multiple meal plans exist on date of room 
move for both inventories. 

5.4.133 235854 

No EMV and manual entry of credit card on front desk reservation, when cursor is 
past credit card number field, dialog box appears multiple times “Please complete 
guarantee and settlement before processing card”.  This is for Enter key, Tab and 
Arrow right keyboard actions. 

5.4.146 245771 

Analytic view database table is not associating a building code accurately to 
revenue for past.  

5.4.153 241117 

Daily Balance Check Report not handling inter-property transfers accurately. 5.4.158 252113 

Sales and Catering   

ODT merge is causing program to crash when invalid characters in Name, 
address, city, state on client profile. 

5.4.153 249645 

Spa and Activities   

Status changes on Spa bookings that were posted during night audit (Skip NA 
Srvc Posting = N), from Front Desk Additional Srvcs will allow status update when 
using Cancel All Bookings or Cxl Single Booking, even if spa booking was posted.  

5.4.136 239609 

Spa booking is retrieved by 2 users, getting a record locked message. 5.4.138 240026 

Member   

Member EFT process does not consider partial settlement causing discrepancy 
postings to folio. 

5.4.167 259327 

Owner   

Owner Statement Summary report with remit by property is not showing owners 
who own multiple units. 

5.4.149 248255 

Owners check production remittance numbers with EFT remittance numbers post 
incorrect amounts. 

5.4.154 251593 

Cannot delete unit from owner profile in a single property database environment. 5.4.158 253480 

Owner Check markers <chk_hed.country_code> and <chk_hed.country_name> 
not pulling correct country name and codes. 

5.4.167 261644 

Ensured Owner commissions processing is following Remittance By Type flag for 
owner and for property.  Flag set to Remittance By Type = Unit is accurately 
processing data. 

5.4.173 268977 

Description 
Reported 
Version 

Incident  
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Loyalty   

Enhanced Loyalty emails to follow language specific setup from client profile. 5.4.178 272742 

Ensured newly created loyalty registrations will check first and last name as well as 
email address before creating new client profile with loyalty id.  

5.4.178 300710 

ResWave   

ResWave interface executable gets error array out of bounds dues to 12 or more 
tax codes on a package rate with components uploading to ResWave. 

5.4.159 253592 

ResWave daily amount does not display dates, during start of routine for 
availability.  Also, policy code text not displaying for group reservations made 
within ResWave.  Ensure policy code displays when rates are setup as seasons. 

5.4.165 
5.4.166 
5.4.166 

259204 
260054 
260248 

Ensured ResWave when using Rate Type Group as Promo Codes will show 
correct rates and availability. 

5.4.178 300942 

Ensured ResWave rate type policy show one time when group reservation has a 
priority and special rate in place. 

5.4.178 301039 

Maestro Mobile App   

Members enrollment portal is not allowing reuse of token to charge existing 
members with credit card on file. 

5.4.151 248732 

Enhanced mobile applications to use a cipher suite when in use. 5.4.152 249730 

Interfaces   

Duetto interface enhanced to include “last modified date and time” as per a 
requirement for interface communication.  Also, eliminate activity record creation 
for release of inventory on Cancelled reservations. 

5.4.140 
240812 
241705 

Rainmaker and Duetto interface, ensure all traces are within mutex control, 
causing interface to crash.  Building availability messages are not being built 
completely and interfaced with Rainmaker.  Also, parsing inbound messages 
simultaneously causing interface to crash. 

5.4.140 
5.4.142 
5.4.149 

241700 
242159 
247640 

GDS setup screen “Restrict Mod. If Room Assigned” is set to Y for a particular 
client’s interface.  The Interface will read messages to verify reservations that have 
inventory booked and room numbers assigned.  Then interface will take advance 
deposits or receive a warning message to review reservations. 

5.4.140 241728 

Strenuous Housekeeping rules set to a Y, the total area during Housekeeping 
assignment do not match total area displayed in Summary by Attendant screen. 

5.4.142 241743 

Delphi interface improve extra level of encoding on response messages only.  
Also, send pick up numbers for past dates.  

5.4.143 243309 

PXP Credit Card Processing not displaying the authorized messages received 
back from approvals in the Voucher Field on folio. 

5.4.148 248433 

Siteminder GDS using Other Charges setup is not migrating into maestro correctly.  5.4.149 246620 

Status Tracker and HotSOS interface was not accepting all messages and does 
not update all rooms housekeeping statuses. 

5.4.150 249041 

It Just Works interface does not indicate error to maestro when credit card fails 
during check in on iPad. 

5.4.151 229180 

Increase revenue management interface tracing to get details on where program is 
crashing. 

5.4.157 244956 

Delphi Departed Production report not showing accurate revenue. 5.4.138 250406 
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Version 
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Synxis GDS interface accept company or wholesaler profile as the company in 
maestro. 

5.4.157 252378 

GDS interface inbound reservations with an error is reporting back false errors on 
earlier reservations migrated successfully. 

5.4.157 252396 

New iDeas revenue management systems interface 1-way format.  Ensure the 
routine will send availability last rather than first.  Cleanup configuration screen by 
allowing mixed case usernames/passwords, edit directory names on-screen.  Alter 
the send of reservations for more than a year to prevent retrigger of a long history 
send rather require a reservation start date not to be empty.  Resend Group 
records whenever add or remove reservations as well as send zero block dates for 
group start and end dates.  

5.4.158 
5.4.160 
5.4.161 
5.4.163 
5.4.165 

253254 
254886 
257990 

Enhanced GDS interface to not support SSLv3, TLS 1.0, TLS1.1 and 128-bit 
ciphers. 

5.4.158 253626 

Konami system accepts date in format “Sat Jun 30” instead of “2018-06-30”.  Also, 
is Description field for voucher is blank, pass back Name field. 

5.4.160 254613 

2-way enhanced iHotelier (PMS Connect) interface upload send comments as 
Guestviewable=’0’ (false) and Name=’Reservation’.  

5.4.161 256106 

Enhanced Squirrel POS interface to post to permanent AR accounts. 5.4.162 256336 

Enhance Corporate Export (CE), performance and new table added for folio 
header.  Also, added voucher number details from folios to be sent. 

5.4.165 
253667 
259055 
259121 

GDS Interface messages send all capitals “RESERVATION”.  5.4.167 261581 

Kiosk interface using run of house room type is returning an error. 5.4.167 261850 

Genomi interface sends client information with zero client code if reservation is 
created with no name and left incomplete for a certain time. 

5.4.167 262115 

Corporate Export in multi-property environment is not validating new property 
additions.  Also, in interface screen, show listing of all properties. 

5.4.172 267495 

Enhanced GDS interface Travel Tripper, send messages once during a 
reservation cycle and ensured accurate messages for sharers are sent.  

5.4.172 267908 

Enhanced Delphi interface to properly escape the BookingDetails.Name in 
response messages, as well as do not send partial availability messages for past 
dates.  

5.4.172 
268432 
268447 

Ensured GDS interface will return modification message on valid reservations if 
“Restrict Mod.  If Room Assigned” flag is set to Y.  Do not send on all modification 
messages.  

5.4.173 266240 

Ensured GDS interface will upload accurate amounts for variable packages with 
extra person factoring and yield restrictions if in place. 

5.4.173 269243 

Ensured Kiosk interface will return correct message when a run of house room 
type is successfully assigned to reservation. 

5.4.174 261851 

Ensured revenue management interface for iDeas trace log files will purge as per 
configuration. 

5.4.177 299419 

Ensured revenue management interface for Rainmaker can accept and process 
recommendations. 

5.4.177 299712 

  


